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"Blogging across the curriculum offers students and
teachers not only the ability to infuse writing
into all disciplines, it facilitates connections 1in
ways that plain paper cannot."

Will Richardson, Blogs, Wikis, Podcasts, and Other
Powerful Web tools for Classrooms




Getting Started

To create your blog, go to http://edublogs.org, which will bring you to the registration
page. Scroll to the Sign Up Here button and click!

% e d u b I O g S “really easy and enjoyable to use”

P. Donaghy, ICFE, Dublin, Ireland

Home AboutUs Help & Support Features Video Tutorials Forums Currantly powering 164,328 blogs

Blogging for teachers and students, made easy

1 Effortiessly create and manage students blogs

'
Get started in seconds/! Edublogs Campus
2 Packed with useful features and customizable themes for free the school solution
3 Ready made for podcasting, videos, photos and more SIGN UP HERE FIND OUT MORI
€bedublogs b edu

4 Step by step support with our helpful video tutorials

When the next screen appears, you will be asked to choose a username. You will always
log into your Edublog - including future Edublogs that you create - using this original
username. Your username is just about the only thing about your Edublog that you cannot
later change. Add your email address, enter the verification code, and click on the Next
button.

Tip: Be sure you type in a correct email because if you make a mistake, the username you
originally chose will no longer be available. If you're using a school email, check that your
district does not block Edublogs.

edubloggerfan2

(Must be at least 4 characbers, letters and numbars only. )

Email Address:

gdesler@egusd.nst

(Well send your password to this address, so triphe -check it.

se acl.com or school email addresses as filkers can stop emails from us,., plesse use grmail, hotmail, xahog or other

Edublogs.org is a site specifically for teachers, students, librarisns, ceseacchers,
professors, administrators, corporate trainers and anyone else imvolved in education, by
ticking the box belov you agree that you fall into one of these groups.

1 Agree:

]

Werification:

k
6874

® gimmn » blag!

O} sust 2 username, please

Next »



http://edublogs.org/

You can relax about choosing a Blog Title because, unlike your username, you can change
the title of your blog whenever you wish. Enter your title, select your blog type (teacher,
student, other) and click on the Signup button.

Blogging for teachers and students, made easy

| Enrh i
Fea edubloggerfan2.edublogs.org/
( Your address will be domain.edublogs.org/.Must be at least 4 characters, latters and numbers only. 1t cannot be changed so choose
carafully|
log Tite: . . .
o Connecting, Creating, and Collaborating
Frivacy 1 weuid like my blag te sppasr in public lstings sraund thie site. @ ves Ona
o
Hon Tvps: Please select a Blog Type -
Languaga: English »
[ Signup »

When the next screen appears with your URL (i.e., edubloggerfan2.edublogs.org/Is
Yours), you are almost ready to start blogging!

Blogging for teachers and students, made easy

The blog edubloggerfanZ.edublogs.orgl is yours

But, before you can start uring your blag, yvou must sctivate it
Chatk your inbox st gdeslar2@gmall.com and clizk the link given,

1f yau do not sctivate your blag within tve daye, you will have k& fign up agsin

Check your email for a message from Edublogs with an activation link. Click on the
activation link and head back to your email.

[Edublogs.org] Activate http:HeduhIoggeﬁanz.edublogs.orgf Inbox |
Edublogs.org to me 1:008 PM (2 minutes ago) | 4 Reply

To activate your blog, please click the following link

hitp-Medubloggerfan? edublogs. orgfwp-activate php?key=13edec &7 afabBS

After you acivate, you will recenve “another email™ with your login
After you activate, you can wisit your blog here

hitp:Medubloggerdan?. adublogs. argd

© Reply F orward

A second email should be heading into your box with your password — which you will
want to change (instructions on page 6). Copy your password and click on Login [View
your site shows you what your visitors will see. It’s not your working area (dashboard)].



Your account is now active!

Username: Password: -~

edubloggerfanz

our account is now activate, (Yiew vour site or Login

Enter your username and password.

Login to your blog with the exact user name
and password listed in your Edublog email.
Click on the Login button.

Each time you visit your blog, you'll need to

BEETIA login. From your home page, locate the
edubloggerfan2 Meta section of the navigation bar. Click on
i Login.
Password:
-"r1L
Remember me v Fr4 :

WordPress

- Note: If you're already logged in, instead of
Login, you will see Site Admin.

Viewing Your Blog

There are two views in an Edublog (or any blog, for that matter): the Dashboard, which is
your working area and the View, which is what visitors to your blog will see. Each time
you login, you will initially enter the Dashboard. From this page, you can see any recent
activity on your site and any recent announcements for Edublogs. In the Latest Activity
box, you'll be able to see at a glance if anyone has made new comments to any of your
posts, or if there are comments that need moderation.

Toward the top of the screen is a list of menu options: Dashboard, Write, Manage,
Blogroll, Presentation, Plugins, Users, Options. These options are the same on every panel
you work in inside the Administrative Area.




BlogWalker ~ wisite»

Hawdy, blogwalker. [Sian Out, My Frofile)

[ESOTYPIE] wriite Manage Comments Blogroll Presentation Plugins Users Gptions Upgrades

Merry Christmasl Merry Christmas from all of us at edublogs, to celebrate we've stuffed your stocking with tags and themes.

" p.x. Some blogs may have reverted 1o the default theme or have {5 in their headers .. you can just switch back to your regular theme under Presentation and edit the /5 out under Options... sorry for the

Welcome to your edublog

Use the links below to get started:

« Virite a post

« Write a page

+ NEW - Let the world know about your edublog
« Recommend edublogs to your colleagues and friends
* Upgrade to more storage space

+ Update your profile or change your password

« Manage links in your blogroll

+ Manage your comments

* Manage your existing posts and pages

« Import your stuff fram another blog site

+ Change your site’s look and feel

» Change the name of your site and configure other settings
* Get an ad free Wikispace courtesy of us

» Create ancther brand new blog

o Get help and support for all things Edublogs

Changing Your Password

Latest Activity

Incoming Links More »
+ DOPA Again?!
* Additional Edublogs Resource

Comments »

Comments in moderation (1) >

* blogwalker on Happy 10th Birthday to Blogging! (Edit)
* dogtrax on Happy 10th Birthday to Blogging! (idin)

« hickstro on Back from NYC tede)

+ blogwalker on Back from NYC (Edi

« dogtrax on Back from NYC fedi)

Posts »
« Happy 10th Birthday to Blogging!
+ DOPA Again?!

* Back from NYC
 Remembering Leni Donlan
+ Time of Remembrance: Move Over Ken Burns!

To change your password, click on the Users menu.

BlogWalker

Dashboard Write Manage Blogroll Presentation FPlugins EIESES

Your Profile

Your Profile and Personal Options

Personal Options

M Use the visual editor when writing

Update Your Password

If you would like to change your password
type a new one twice balow. Otherwise |eave
this blank.

New Passwoard:

Type it one more time

Scroll down to the Update Your Password box in the lower right corner of the panel and
enter your new password. Don't forget to click on the Update Profile button (bottom right-

hand corner) in order to save your new password.

Changing Other Information in the Users Panel

You cannot change your username. However, you can change your nickname. This is the
name that is displayed by any posts that you create. Simply type your new nickname in the

Nickname box and click the Update Profile button.




Your Profile and Personal Options

Personal Options

W Use the visual edivor when writing
Primary Blog

http://blogwalker edublogs.org/ -
Update Profile =

Name Contact Info

Username: [no editing) E=mail. (required)

gailhd@jps.net

First name Website

http://blogwalker.edublogs.org/

Last name AlM

Nlckname/ Wahoo |M

gail

Display name publichy as. Jabber § Google Talk
blogwalker

You will need to select your new display name from the drop-down menu. Press Update
Profile once more.

Note: Your email address will not be displayed on your blog or in your profile. This
information is used by Edublogs.

Click on Update Profile and head back to your dashboard.

Designing the Layout of Your Blog

Everybody enters a newly created Edublog with the same default theme
(presentation/layout/design). To view the default theme, scroll to the top of your blog and
click on View site.

Connecting, Creating, and Collaborating ~ wiesste.»

DEROTEETEY write Manage Comments Blogroll Presemtation Plugins Users Options Upgrades

Dashboard @3

Tip of the Moment: Wondering where your Flash and Embed Media buttons have gone? Here's the explanation and how 1o embed flash

1
blog posts.

Welcome to Edublogs

You will be able to change and customize your theme whenever you wish. The default
theme has two sidebars (one on the right; one on the left). Posts are in the middle. In this
particular theme (and in most of the themes), the image in the header can be customized.



Let’s head back to your dashboard and take a look at the setup options — and widgets — that
come with the default theme. Click on Site Admin to return to your dashboard.

Connecting, Creating, and Collaborating

Just another Edublogs.org weblog

GETTING STARTED Hello world! LATEST POSTS

» This sic

can

ar explains how you = Hallo world

Welcome to your brand new blog at Edublegs.

» Read and then replace with

Widgets (see below)

Iy log in, edit or delete this post and check out all the other BLOGROLL

s Edublegs

UPLOADING YOUR AVATARS LR
e Asanedublogs u 1av
ravata
. ARCHIVES
and
auser avatar here If you've got 4 minutes and 55 seconds, we've also put together a video » Ms

introduction that you raght like:

n >Lustom
»upload and
new header image

Create another blog

= Edubl

CHANGING YOUR SIDEBARS

- WMars esulaiiccsvevealddboe

From your dashboard, click on the Presentation tab.

-

Connecting, Creating, and Collaborating ~ wiewsie»)

DELVLLETGE Write Manage Comments Blogroll Fresentation  Plugins Users Options Upgrades

Dashboard

! Tip of the Moment: Confused about the difference between tags and categories? Learn how to use them herel

Click on Widgets. This is where the fun begins! New themes, along with great widgets
(doodads that appear in your sidebar, such as links, calendar, text boxes, archives, etc.), are
added to the Presentation menu on a regular basis. To get started, click on the Widgets tab.



Plugins Users Options Upgrades

! Tip of the Moment: Want accurate statistics onyour blog subscribers? Eecome an Edublogs supporter and re

Current Theme

| Edublogs Default 1.0 by Edublogs

The default Edublogging theme, adapred from Chris Pearson's work.

To setup your sidebars, simply drag the widgets you want from the Available Widgets box
and drop them in the sidebar(s) in whatever order you wish. Don’t worry, you can always
rearrange later. Be sure to add the Meta widget, as this is where you will find your Site
Admin link for logging in or logging off. For a more detailed explanation of the Edublogs
widgets, refer to the Widget Glossary (page 22).

To save your new setup, click on Save Changes.

[ T

Tip of b el Frotty st sl e rdieing Coele = (o0l o o] e wel (o b Copeand wrel panbed ety il etber fast Datag fr i g fee mekged
e e b

Sidebar Arrangement

s Lot B ] A wrlipr G e el i
Ll Sl lodor Raght Sidebar .I

CiaPaasli Lodabem Dwlaadt adrbar

Awailable Widgety

-

Creating, and Collaborating ~ wiewsie-)




Creating a Post or Page

To write your first post, click on the Write menu, give your post a title, add your content,
and click the Publish button if you are ready to “go live” with your piece. The Save and
Continue option saves and keeps the post open. The Save option saves your post as a draft,
which you can reopen whenever you wish.

You have a number of options available in the formatting bar, such as bold, italic, and
create a bulleted list.

Howdy, blogwalker. [Sign Gut, My f

s Blogroll Pr Plugins Users Options Upgrades

Merry Christmas! Merry Christmas from all of us at edublogs, 1o celebrate we've stuffed your stocking with tags and themes.

" pux. Soem blogu may hava ravarted 1o the default thame or have f5 in their haadars... you can just sitch back 10 your regular thams under Presantation and sdit the f5 out under Options. . sorry for the
mmmmm

Your Drafts: Youth Yoices 2007, Voice Thread, CTAP3 - Sept Cet Together, and & more,

Title Categaries
21st Century Classrooms
Post
add
Wisual Code
o = Separate multiple Cateqories
-Fomal- v B 7 U wx|iZ IS gE EFEIRNT- (DA with commas
v E—|9 X A-E-Q | @GHE -
215t Century Toolbox
Web 2.0..] I aawe
™ a3wPBlogs
I Blog Classes
I” Blogging
Pathc . ™ Biogran
Tags (separate multiple tags with commas: cats, pet food, dags) ™ Blogs N
ciF

Saved at 11-10:32. Save and Continue Editing Save Publish

Editing a Post

You can edit any post from either the View site screen or your Dashboard. To edit from
the View site screen, locate the post and click on the Edit This link.

ElectricPen
g?&%::z April 2, 2006 Search:
. Elk Grove Teachers Lead
Categories:
Uncategorized the Way with Purposeful Search

Archives: Blogging
April 2006 teqariz # 1:15 pr Blogroll
March 2006 Blogsaver
> 1 inc b
ave teachers are experimenting with

blogs as a tool for ...

Commeants (01 Permalink TrackBack R3S

To edit a saved or published post, from your Dashboard, click on Manage > Posts. Click
on the Edit link.

10



Howdy. blogwalker. [Sign Out, M

BlogWa

Dashboard Write IUENEGER Blogroll Presentation Plugins Users Options Wikispaces

Your Drafts: More Teachers Enter the Elogoshere .

Last 15 Posts

Search Posts Browse Month Browse Category

Search Movember 2006 + Show Month All b Show Category
I When Title Categories Comments Author
3s 12?212_:]1:3:!?’: Podcasting - Hear you later Uncategorized 1] blogwalker View @ Delete
31 lzgo;—ggf: We do NOT need DOPA Uncategorized 2 blogwalker  View Edit Delete
20 12?)4%_3;_;; Moving from Manila to WP Elogs, Blog Classes, NWP [s] blogwalker View Edit Delete

Regardless of which screen you choose for editing your posts, remember to click on the
Save button when you have completed editing and/or revising your post.

Creating Pages

For the most part, you will be creating posts. If you wish to post a more static item that
would not necessarily be open for comments, such as an About Me page, this is when you
would write a Page rather than a Post. From your Dashboard, click on the Write menu and
select the Write Page option.

Howdy, blogwalker.

Manage Blogroll Presentation Plugins Users Gptions Wikispaces

Write Post | Write Page

Enter your title, type (or paste) your page content, and click on the Publish button.

Howdy, blogwalker. [Son Out

BlogWalker «

Write Page

Page Title
About Me

Editor HTML
B I oU LElxxswa 2B CH
Pasgach & = = if EEam 9 Al bk )
Ve Dewl] d ClassToonl LedCiier 108 QU+ yediy dlild Hlave Dol QaDUIIIK WILTE LeCTIOMORKY M I\ 12 CrasSTOOHIN 100 Ui ey, 1V ~
years. In a textbook, test-score driven climate, I am an advocate for technology integration that builds online communities
and fosters critical thinking.
I currently work for the Elk Growv: trict as a technology support specialist. |
Pt p Page Author +

Save and Continue Editing Save

Note: In the Post Pages Panel, the Page Parent feature allows you to organize your pages
into subcategories. The Page Order option allows you to organize the order in which your
pages appear. Unfortunately, this feature does not seem to work in many of the WordPress
themes.

11



Adding Hyperlinks to a Post (or Page)

Blogs posts often include hyperlinks, which take your readers to other blogs, websites, or
even to another area within your blog. To create a link from your blog to the district
website, for instance, start by selecting the word or phrase you wish to turn into a link.
From the formatting bar, click on the chain link icon.

Post

Editor TTC

BrUsEBELExxav @B CH
Pasgaph v 1= 1= i EEIE(F9 || @

& teachers are exploring the power and potential of social networking. Check out some of our projects: Youth
st to Coast, Hidden Histories, and Youth Radio.

Path p

/I Insert /edit link -- Web Page Dialog x|
Insert/edit link Type or - better yet — paste in the
Link URLS [ip i wweagusdinat URL. Click on Insert. Whatever
Targat: [Seen tink in th same window i you selected in your post is now
Tites ; underlined. To test your link, click
— on View site.

tp:fielectricpen e o) Irternet

Adding Anchor Links

Anchors allow you link to a specific location on the same post or page. To insert an anchor
link, position your cursor to the place you want the link to point to, and click on the anchor
icon. When the Insert/edit anchor box appears, enter a logic name for the anchor. Click on

Title

Thinking about Writing
Post View »
Visual Code
Pasgeph v B(Z|U M| SR F EETEY-|2QA
b % — X A-®-Q|@Ena

"In fact, blogging isn't a medium for sharing what you've learned, but writing your way into
understanding, or as Toby Fulwiler (Teaching with Writing) writes, a way of bringing order to
chaos. To deny students the opportunity, and what Nanci Atwell refers to as the TIME and
OWNERSHIP of their ideas. is incrediblu oroblemagic.” Y.

‘{
Path: blockguote » p » em

Tags (separate multiple tags with commas: cats, pet food, dogs|
Adora Svitak, Carolyn Foote, literacy, Miguel Guhlin, writing

Insest/edit anchor ’

Insert/edit anchor

Anchor namae: |atwell

Insert Cancel

Save and Continue Editing Save

To link text somewhere else in your post back to the anchor link, scroll the text and select
it. Click on the chain icon. When the Insert/edit link box appears, type the pound sign #
and whatever you named your anchor (i.e., #atwell). Click on the Insert button.

12



Creating Categories

Categories make it possible, at the click of the mouse, to reorganize your chronological
postings according to themes or subjects. To set up categories for your blog, click Manage
> Categories. Scroll to the Add New Category box, enter your new category, and click on
the Add Categories button (bottom right-hand corner).

Howdly, blogwalker. [Sign Out,

Categories (add new)
[»] Name Description Posts Bookmarks Action
4076 EBlog Classes 1 Q Edit Delete
122 Blogging [s] o] Edit Delete
2378 Elograll o s} Edit Delate
568 Eloas 5 s} Edit Delate

Assigning Categories

The default category for any post is Uncategorized. To assign a different category, click on
the category you wish to assign to the post. You can assign a post to multiple categories.

Dashboard Write LIEUELTR Blogroll Presentation Plugins Users Options Wikispaces

(TR0 Pages Uploads Categories Comments Awaiting Moderation (1) Import

Title
More Teachers Enter the Blogoshere

Post
Editor HTML

Add

p Separate multiple categories

B 7 U s L2(xxavQ @@ CH with commas

Pasgwh Wi ISR E | EEAE|F 9 o | D[ @ &

Elk Grove teachers are exploring the power and potential of social networking. Check out some of our projects: Youth

Radio, Youth Voices Coast to Coast, and Hidden Histories. o
I Blogroll
P
o 4 ™ Blogs
v
Savina Draft... Save and Continue Editing Save Publish

Adding Tags to a Post
Let’s start by looking at the difference between a category and a tag:

“Categories are your blog’s table of contents. Don’t remove them, thinking tags are a better option.
They aren’t. Your posts must be categorized. Remove them and they will be categorized as
“uncategorized”, something you do not want, trust me.

Tags are like your blog’s index. They are keywords that represent the micro-categorization of your
blog’s content. To work effectively, they need to be words that people search for, called search
terms.

13



Categories are automatically marked as tags in WordPress. Theoretically, your blog doesn’t need
tags. But many like the notion of breaking down the words that describe their content beyond
categories, and tags offer that ability.” *

Title
Thinking about Writing
Post
Yisual | Code —
~Fomat- » B F U | iS = g EEEIET- P&
G g — x x A-¥-0 | &6 &
e

I spent the weekend revisiting some of my favorite mentors on the art of teaching
writing: Manci Atwell, Donald Graves, Lucy Calkins and Ralph Fletcher. Thank
goodness the many, many post-it notes are still in place; o it did not take me long to
find the gems that made for the perfect writers' workshop while I was still in the

Pg y
Lseparate multiple tags with commas: cats, pet food, dogs) 7

Adora Swvitak, Carolyn Foote, literacy, Miguel Guhlin, writing mentors \.,_::

Save and Continue Editing | Sawve

To add tags, type in your keywords, separating multiple tags with commas.

*Explanation copied with permission from Lorelle VanFossen on WordPress-
http://lorelle.wordpress.com/2007/09/21/tags-arrive-on-wordpresscom-blogs/

Adding Links to Your Blogroll

To add a link, start by clicking on the Links in your Dashboard sidebar(s). Choose the Add
Link option. Type or copy and paste the URL and add the Link Name (this is what your
readers will see when they view your sidebar(s) rather than the actual
http://www.equsd.net/ web address). Click on the Add Link button.

Note: If your Blogroll does not appear in the sidebar, you will need to return to
Presentation and drag and drop the links widget into your sidebar.

Howdy, blogwalker. [Sign Out, M

Dashboard Write Manage Il Presentation Plugins Users Options Wikispaces

Add Link

MName:

Bud the Teacher

Address: |pyy phudtheteacher. typepad.com

add
Description:

Separate multiple categories
with commas.

add Link » ™ Blog Classes »

™ Blogging
™ Blogron
I Blogs

14


http://www.egusd.net/

The default category for sidebar links is Blogroll. A description is not required, but if you
add one, it will appear when visitors hover over the link.

If you are planning on adding many links, you'll probably want to create categories for
your links. Click on the Link Categories menu to add your categories. Once you have
added Link Categories, you can assign all your links to the appropriate link categories.

If you don’t feel the Blogroll has enough space for all your links, you could also create
Pages for your links, such as a Math Page with links, or a Teacher’s Resources Page.

Changing the Presentation (Theme)

Tired of your theme? No problem. From your Dashboard screen, click on the Presentation
tab and head back in to select a new one.

Blog\\valkel' . (View site »)

Dashboard Write Manage Comments Blogroll IIESIIICULUN Plugins Users Options Upgrades

ALTIOTES Widgets Custom Image Header

! Tip of the Moment: Want to get sneak previews and latest Edublogs news before everyone else hears it?

Current Theme

| MistyLook by Sadish

Available Themes

Click on any of the themes to update your blog. To see what your new theme looks like on
your site, click on the View site link (top of your blog, next to your blog name). Most
themes are customizable, making it possible for you to change color themes, upload an
original graphic in the header, etc. All themes have a selection of widgets that you can drag
and drop onto your sidebar(s).

Note: For a comprehensive introduction to Edublogs widgets, visit Sue Waters’ (The
Edublogger) online explanation “limits to Customizing Widgets” at
http://theedublogger.edublogs.org.

15


http://theedublogger.edublogs.org/

TO add Wldgets tO your bd Write Comments Blogroll EIEEITIEULNY Flugins Users Options Upgrades
sidebar, click on the —
Presentation link and
select the Widgets tab. Sidebar Arrangement

You can drag and drop widgets onta your sidebar below.

! Off topic: Do me a favour ;) Vote for Tessa Farmer in The Times/ The South Bank Show Breakthrough Award! {more info here)

Save Changes »

Scroll down to view the

available widgets. Sidebar

You can drag and drop - =
the widgets up to the =
sidebar(s).

Below the Available Widgets box are options to choose how many Text (these are really
handy in a sidebar!), RSS Feed, Widgetbox Widgets and Video Widgets you would like.

When you have finished selecting and customizing a theme, click on the Save Changes
button. To view your new theme, click on the (View site) link.

Howdy, blogwalker. (Sign Out, My 1

BlogWalker ~ iews

Dashboard Write Manage Comments Blogroll [E=IJIeULLY Plugins Users Options Upgrades

!  Off topic: Do me a favour ;) Vote for Tessa Farmer in The Times/ The South Bank Show Ereakthrough Award! (more info here)

Sidebar Arrangement

You can drag and drop widgets onto your sidebar below.

Uploading Images, Documents, or Podcasts to Your Blog

The first step to adding an image file (jpg, gif), a document file (Word, Excel, PowerPoint,
PDFs), or a podcast is to browse to and upload the file to your blog. From the Write Post
or Write Page panel, scroll down below the post area until you see the area for uploading.
Click the Browse button and navigate to wherever you have saved the file(s) you wish to
upload. You may put a title or leave this line blank. Note: If you leave it blank, Edublogs
will use the file name for the title.

16



Title

More Teachers Enter the Blogosphere

Post

Editor HTML

B 7 U & JExxaowQ (@@ CH
Foma- M ST EEAE|F s

v

Elk Grove teachers are exploring the power and potential of social networking. Check out some of our projects: Youth
Radio, Youth Voices Coast to Coast, and Hidden Histories.

Path

Upload SREGTEE

File C:\Documents and Settings\gdesler\My Documents\ncte\children2.jpg

Title

Description

Vi

Save and Continue Editing | Save

Upload » i

When you click on the Upload button, the image or document appears in the bin.

Upload Erawse all
podcast.jpg — Edit
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After your image or document has been uploaded
to the bin, click on the Send to Editor link — or
just drag and drop the image into your post.

To resize an image, click once on the image to
select it and drag one of the corner handles.

Formatting Images

To re-position an image, click on the tree icon and select an alignment option. To add
some padding around your image, add a few pixels to the Vertical space and/or Horizontal

space boxes.
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Note: To add multiple images and/or files
to the same post, click on Upload and
browse to the next image
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Changing Your Blog’s Tagline

If you have selected a theme that includes a tagline, you’ve probably noticed that the
default tagline is “Another Excellent Edublogs Blog.” To edit the tagline, go to your
Dashboard and click on the Options tab. Check to see that you are in the General screen.
Scroll down to the Tagline window and add your own tagline. Click on the Update
Options button.

Note: Not all themes include a tagline.

BlogWalker ~ wiewsie-)

Dashboard Write Manage Comments Blogroll Presentation Plugins Users Eoloi{LLLY Upgrades

Writing Reading Discussion Privacy Delete Blog Avatar Subseribe to Comments AMP

General Options

Update Options »

Blog title:  Blogwalker

__—. Tagl'me: Muddling through the blogosphere in search of *unlimited education®...
In a few words, explain what this blog is about.

Monitoring Your Blog

Concerned about the possibility of someone from the general public posting inappropriate
comments to your blog? No need to worry because you have complete control of what is
actually published to your blog. For maximum control, make sure the first two options
under Before a comment appears box are checked.

Howdy, blogwalker. [Sign Out, !

Discussion Options

Update Options »
Usual settings for an article:
(These settings may be overridden for individual articles.)

» ¥ Attempt to notify any Weblogs linked to from the article {slows down posting.)
= || Allow link notifications from other Weblogs (pingbacks and trackbacks.)

» ¥ Allow people to post comments on the article

E-mail me whenever:

« ¥ anyone posts a commem

+ || a comment is held for moderation

Before a comment appears:

o ¥ | An administrator must always approve the comment
« ¥ comment author must fill out name and e-mail

« [ Comment authar must have a previously approved comment
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By selecting the E-mail me whenever anyone posts a comment option, you will receive an
email message that looks something like this:

| amew ~ |28 3 i 3 | - [ 2 | @nen

+ 018 From St reeved . EDEE

&  odesler@equesdnet  [BlectricPen] Pleass modersts: JEB ... Sun 4/2/2006 5:16 P
= gdesler@egusdn., [HectricPen] Please moderate:... Sun 4/2/2006 5:10... 3 KB

Moderating Comments

To moderate comments, go to Manage > Awaiting Moderation (Note the (1), which
indicates one comment is awaiting your approval or deletion.

BlogWalker

Dashboard ‘Write EIEUEGEN Blogroll Presentation Plugins Users Options Wikispaces

M Awaiting Moderation (1) JREGTSOTSN 11 S

Approving Comments

To approve a comment, click on the Approve radio button and click on the Moderate
Comments button. If you click on the View site link, you will see that the approved
comment now appears under the Comments link of that particular post.

Moderation Queue

1. Name: socrates | E-mail: gdesler®egusd.net | IP. 68.166.37.78 | Date: April 2, 2006

Purposeful blogging is hard to pin down.

Edit | View Post | Delete just this comment | Bulk a.ctiun.ﬁppmw O Spam T pelete T Defer until later

Moderate Comments »

Editing Comments

Helen | Helen@bulernet | 1P 20720011667

You're class Aid 4 great Job with you're pOdcast! | love the wiry you uled & vanety of words! After listening 1O your podcast, I'm
even more excited than before to start posting!!

-Helen \

N 18, 218 AM — [ Edt | Delete | Unapprove | Spam | — Persona Narratives from New Jersey

Helen | Helen@batlernet | 1P 20720011667

You're class Ad 4 great Job with you're pOdcast! | love the wiry you used & vanety of words! After listening 10 your podcast, I'm
even more excited than before to start postinght

-Helen \

Jn 18, 218 AM — [ Edt | Delete | Unapprove | Spam | — Persona Narratives from New Jersey
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When your code view opens, select italic and/or bold so that your comment will be
noticeably different from your student’s comment, and add your comment. When you’ve
finished, select italic and/or bold to close your comment, and click on the Edit Comment
button.

Comment
Ink b-qudte del ins img ul ol I code mcre [ookup @close tags

Your class did a great job with your podcast! [ love the way you used a vanety of words! After listening to yiur podecast, I'm
even more excited than before to start posting!!

~Helen
Zstrongs<aem>Helen, | too am very much looking forward to 8utlr's upcoming podcasts!

Hope to hear you soon,
Mrs. Desler </strong></em>|

Personal Narratives from New Jersey »

~— Edit Comment »

Adding Edublog Community Users

If you wish to limit posting comments on your blog to Edublog members only or to
provide greater posting privileges to certain individuals, you will need to add their email to
your Users list. From your Dashboard, click on the Users menu > Authors & Users. Scroll
down to the User Email box and type the email address. Before clicking on the Add User
button, think about the permission level you wish to give an individual user.

Connecting, Creating, and Collaborating -~

: age Comments EBlogroll Presentation  Flugin Options  Upgrades

LN LTSN R IEES Your Profile  Add Users Your fvatar Blog & User Creator  Irwvites

When you add users, you can also determine what their permissions (capabilities) are by
assigning one of five roles from the Role drop-down box. The default selection is
Subscriber. A Subscriber can see the Dashboard and edit his/her own profile. That is all. A
Contributor can draft posts but cannot publish them. An Author can publish posts. An
Editor can edit other people’s posts and can manage categories, links, comments, and
pages. An Administrator can do everything. Each role is simply a set of capabilities. The
Editor and Administrator roles have the capability to edit posts that do not belong to them.
They can edit anyone’s posts, including each other’s.

Add User From Community

Type the e-mail address of another user to add them to your blog.

User E-Mail: efudd@egusd.net

Role: Subscriber v
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Limiting Comments to Edublog Community Members

If you wish to limit posting only to members you have added to your Edublog community,
go to your Options menu > General. Click in the Membership checkbox to require that
users are registered (members of your community) and logged on in order to comment. By
selecting the Membership option, anyone who clicks on the comment link for any post,
will be redirected to a WordPress login box. Don’t forget to click on the Update Options
button.

Howdy, edubloggerfan. [Sign Our, M

Connecting, Creating, and Collaborating -«

Dashboard Write Manage Comments Blogroll Presentation Plugins Users

! Tip of the Moment: Read our tips on how to change your display name and set up your comment avatar,

General Options

Update Options =

Blog title: |Connecting, Creating, and Collaborating

Tagline:  Teaching and Learning in a Digital Age
Im a few words, explain what this blog is about.

Membership;@sers must be registered and logged in to comment

E-mail address: adeslerzfgmail.com

This address is used only for admin purposes. |f you change this we will send you an email st your niew address
to confirm it. The new address will not become active until confirmed.

Blog lanquaqe: | English ~

Looking for More Edublogs Resources?

e Start by subscribing to Sue Waters’ “The Edublogger” -
http://theedublogger.edublogs.org/ - “which is jammed with helpful tips, ideas and
more.” \

e Check out the video tutorials posted at Edublogs.org - http://edublogs.org/videos/
Visit the Edublogs Forum - http://edublogs.org/forums/

e Edublogger Mike Temple also offers excellent tutorials for the advanced user at his
Edublogs Tutorials site - http://miketemple123.edublogs.org/.
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Edublogs Glossary of Widgets*

Archives — Having an archives widget in your sidebar is like having a file cabinet with
folders organized by month and year. By clicking on a May 2006 archive link, for
example, a window will instantly open displaying all your posts from that month and year
—a much faster way to access previous posts than by scrolling back through months and
years!

Avatar — A graphic or photo that in some way represents the blogger. Edublogs provides
you with the option of uploading two types of avatars: 1) blog avatar — appears on the front
page of your blog, and 2) user avatar — appears when you comment in your blog, or on
another Edublogs blog, or in the forum. Your blog and user avatars can be the same image
or different images.

Calendar — The calendar widget is another great organizing tool, similar to the archives
link. When placed in the sidebar, the calendar widget displays the current month, with a
link to previous months. Dates on the calendar that appear in bold type indicate dates that
you have posted and they are hyperlinked to the actual posts.

Categories — Another great tool for organizing, the categories widget is like the drawer of
a file cabinet. You can create as many categories as you wish. Each time you assign a
category — or multiple categories — to a post, they will appear in your sidebar as hyperlinks
to all posts you have assigned to those categories. Categories are much like a table of
contents for your blog.

ClustrMaps — Your students will love this widget — and will probably improve their
knowledge of world geography as they check for red dots appearing on the world map as
readers from around the world visit their blog project.

Del.icio.us — Del.icio.us (http://del.icio.us/) is a social booking marking tool that allows
you to access your online books marks from any computer — and to share them with others.

Email Subscriptions — This widget makes it very easy for readers to subscribe to your
blog. By typing their email address in the box and then clicking on the Subscribe button,
they will receive an email each time you add a new post.

Flickr — Although blocked by many school districts, the flickr (http://flickr.com) widget
allows you to display the lastest photos you’ve added to your flickr account.

Google Search — Just one more option you can offer your readers: access to the world’s
most popular search engine.

Links — This links widget will be the section in your sidebar(s) for links to other blogs and
websites. You can organize your links by categories (i.e., Math, English, Blogroll)

Meta — This widget provides you with a login to your dashboard. Without the meta
widget, you would have to go to Edublogs.org each time you wanted to get into your
dashboard.
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Pages — Pages are where bloggers keep more static information (e.g., about me, blog
etiquette, grading policies, etc.). Depending on the blog theme you select, pages will either
appear in the sidebar or in tabs across the top of your blog. Pages always appear in a
separate area from your posts.

Recent Comments — Another very motivating widget for students. When you place this
widget in your sidebar, readers will see snippets of your most recently approved
comments.

Recent Posts — Similar to the recent comments widget, the recent posts widget will show
snippets of your most recent posts.

RSS - This widget will show up in your sidebar — or maybe in your header, depending on
your theme, as a small orange icon. By clicking on the RSS icon, your readers who use
news aggregators (i.e., Bloglines, Google Reader, Pageflakes) can “subscribe” to your
posts and/or comments, which means, rather than receive notification via email, they open
their news aggregator to see what’s new in your blog.

Search — Another handy way for readers (or you) to locate information within your blog.

Tag Cloud — This widget will check you posts for “tags,” which differ from “categories”
in that they are more like items listed in an index. Generally, tags are words that are
actually included in a post. If I post about a rubric for evaluating podcasts, for instance, I
might tag the post with “rubric” and “podcasts” (and also assign it to a broader category
such as “Assessment”). If you’re tagging your posts and include a tag cloud widget in
your sidebar, readers will be able to see at a glance what topics you are posting about and
how frequently you write about those topics, as the more frequent the tag, the larger it
appears in the tag cloud.

Text — Text boxes allow you to add more than just text to your sidebar. Besides adding,
for instance, a favorite quote in a text box, you can also paste in some pretty fancy
JavaScript, iframes and object codes, such as the code for adding a “voki” (speaking
avatar) to your sidebar.

Twitter — The Twitter (http://twitter.com) widget allows your readers to view your latest
“Tweets” (up to 140 character, a “micro blog”) from your Twitter community.

VodPod Videos — Many districts block this widget, which allows you to share the latest
videos you’ve uploaded to your account (http://vodpod.com).

*Widgets — “In simple terms widgets are mini web applications that you can put onto your
website.” To learn more about widgets, visit “The Edublogger” tutorials at
http://theedublogger.edublogs.org/2008/01/19/getting-more-out-of-widgets/#more-19.
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